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Second Stage 

Computer Science - First Semester 
Microsoft Excel Spreadsheet 

 

This Course covers all the fundamental techniques you need to know in order to create, 
edit, format, and print your own worksheets. In addition to showing you around the worksheet, 
also exposes you to the basics of charting, creating data lists, and performing data analysis. 
Keep in mind, though, that this course just touches on the easiest ways to get a few things 
done with these. In this part, I break down the Excel user interface and make sense of the tabs 
and command buttons you’re going to face day after day after day. Of course, it does you no 
good just to know what’s what onscreen; you need to be able to use all these bells and whistles 
(or buttons and boxes in this case). Therefore, I also show you how to use some of the more 
prominent buttons and boxes to enter your spreadsheet data. From this humble beginning, it’s 
a quick trip to total screen mastery. 

Latest Excel user interface includes all sorts of graphical improvements. Foremost is Live 
Preview that shows you how your actual worksheet data would appear in a particular font, 
table formatting, and so on before you actually select it. Additionally, Excel supports an 
honest to goodness Page Layout View that displays rulers and margins along with headers and 
footers for every worksheet and has a zoom slider at the bottom of the screen that enables you 
to zoom in and out on the spreadsheet data instantly. Finally, Excel is full of pop-up galleries 
that make spread- sheet formatting and charting a real breeze, especially in tandem with Live 
Preview. 

The Excel User Experience 
In this lecture: 

 

Ø  Getting familiar with the Excel program window and Backstage View  
Ø  Selecting commands from the Ribbon � 
Ø  Customizing the Quick Access toolbar 
Ø  �Methods for starting Excel 
Ø  Surfing an Excel worksheet and workbook 
Ø  �Getting some help with using this program � 
Ø  Quick start for users migrating to Excel from earlier versions using pull-down menus 

 
The Excel user interface, scraps its reliance on a series of pull-down menus, task panes, and 

multitudinous toolbars. Instead, it uses a single strip at the top of the worksheet called the Ribbon that 
puts the bulk of the Excel commands you use at your fingertips at all times. Add to the Ribbon a File 
tab and a Quick Access toolbar — along with a few remaining task panes (Clipboard, Clip Art, and 
Research) — and you end up with the handiest way to crunch your numbers, produce and print 
polished financial reports, as well as organize and chart your data. In other words, to do all the 
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wonderful things for which you rely on Excel.  

Best of all, this new and improved Excel user interface includes all sorts of graphical 
improvements. Foremost is Live Preview that shows you how your actual worksheet data would 
appear in a particular font, table formatting, and so on before you actually select it. Additionally, 
Excel supports an honest to goodness Page Layout View that displays rulers and margins along with 
headers and footers for every worksheet and has a zoom slider at the bottom of the screen that enables 
you to zoom in and out on the spreadsheet data instantly. Finally, Excel is full of pop-up galleries that 
make spread- sheet formatting and charting a real breeze, especially in tandem with Live Preview. 

 

Excel’s Ribbon User Interface  
When you launch Excel, the program opens the first of three new work- sheets (named Sheet1) in a 

new workbook file (named Book1) inside a pro- gram window like the one shown in the figure 
bellow.  

 

The Excel program window containing this worksheet of the workbook contains the following 
components: 

✓ File tab that when clicked opens the new Backstage View — a menu on the left that contains all 
the document- and file-related commands, including Info (selected by default), Save, Save As, 
Open, Close, Recent, New, Print, and Save & Send. Additionally, there’s a Help option with add-
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ins, an Options item that enables you to change many of Excel’s default settings, and an Exit option 
to quit the program. 

✓ Customizable Quick Access toolbar that contains buttons you can click to perform common 
tasks, such as saving your work and undoing and redoing edits.  

✓ Ribbon that contains the bulk of the Excel commands arranged into a series of tabs ranging from 
Home through View.  

✓ Formula bar that displays the address of the current cell along with the contents of that cell.  
✓ Worksheet area  that contains the cells of the worksheet identified by column headings using 

letters along the top and row headings using numbers along the left edge; tabs for selecting new 
worksheets; a horizontal scroll bar to move left and right through the sheet; and a vertical scroll bar 
to move up and down through the sheet.  

✓ Status bar  that keeps you informed of the program’s current mode and any special keys you 
engage, and enables you to select a new worksheet view and to zoom in and out on the worksheet. 

 

Bragging about the Ribbon 
The Ribbon changes the way you work in Excel. Instead of having to memorize (or guess) on 

which pull-down menu or tool- bar Microsoft put the particular command you want to use, their 
designers and engineers came up with the Ribbon that shows you the most commonly used options 
needed to perform a particular Excel task. 

 

Keeping Tabs on the Excel Ribbon 
The first time you launch Excel, its Ribbon contains the following tabs from left to right: 
✓ Home tab with the command buttons normally used when creating, for- matting, and editing a 

spreadsheet, arranged into the Clipboard, Font, Alignment, Number, Styles, Cells, and Editing 
groups. 

✓ Insert tab with the command buttons normally used when adding particular elements (including 
graphics, PivotTables, charts, hyperlinks, and headers and footers) to a spreadsheet, arranged into 
the Tables, Illustrations, Charts, Filter, Links, Text, and Symbols groups. 

✓ Page Layout tab with the command buttons normally used when pre- paring a spreadsheet for 
printing or re-ordering graphics on the sheet, arranged into the Themes, Page Setup, Scale to Fit, 
Sheet Options, and Arrange groups. 

✓ Formulas tab with the command buttons normally used when adding formulas and functions to a 
spreadsheet or checking a worksheet for formula errors, arranged into the Function Library, 
Defined Names, Formula Auditing, and Calculation groups. Note: This tab also contains a 
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Solutions group when you activate certain add-in programs, such as Analysis ToolPak and Euro 
Currency Tools. 

✓ Data tab with the command buttons normally used when importing, querying, outlining, and 
subtotaling the data placed into a worksheet’s data list, arranged into the Get External Data, 
Connections, Sort & Filter, Data Tools, and Outline groups. Note: This tab also contains an 
Analysis group when you activate add-ins, such as Analysis ToolPak and Solver. 

✓ Review tab with the command buttons normally used when proofing, protecting, and marking up 
a spreadsheet for review by others, arranged into the Proofing, Language, Comments, and Changes 
groups. Note: This tab also contains an Ink group with a sole Start Inking button when you’re 
running Office on a Tablet PC or a computer equipped with a digital ink tablet. 

 

✓ View tab with the command buttons normally used when changing the display of the Worksheet 
area and the data it contains, arranged into the Workbook Views, Show, Zoom, Window, and 
Macros groups. 

 

In addition to these standard seven tabs, Excel has an eighth, optional Developer tab that you can add 
to the Ribbon if you do a lot of work with macros and XML. 
 

Although these standard tabs are the ones you always see on the Ribbon when it displays in Excel, 
they aren’t the only things that can appear in this area. Excel can display contextual tools when you’re 
working with a particular object that you select in the worksheet, such as a graphic image you’ve 
added or a chart or PivotTable you’ve created. The name of the contextual tools for the selected object 
appears immediately above the tab or tabs associated with the tools. 

 

Selecting Commands From The Ribbon 
The most direct method for selecting commands on the Ribbon is to click the tab that contains the 

command button you want and then click that button in its group. For example, to insert a piece of clip 
art into your spreadsheet, you click the Insert tab and then click the Clip Art button to open the Clip 
Art task pane in the Worksheet area. 

 

The easiest method for selecting commands on the Ribbon — if you know your keyboard well — is to 
press the Alt key and then type the sequence of letters designated as the hot keys for the desired tab 
and associated command buttons. 

 

When you press and release the Alt key, Excel displays the hot keys for all the tabs on the Ribbon. 
When you types one of the Ribbon tab hot keys to select it, all the command button hot keys appear 
along with the hot keys for the dialog box launchers. To select a command button or dialog box 
launcher, simply type its hot key letter(s). 

 

If you know the old Excel shortcut keys from versions Excel 97 through 2003, you can still use 
them. For example, instead of going through the rigmarole of pressing Alt+HC to copy a cell selection 
to the Office Clipboard and then Alt+HV to paste it elsewhere in the sheet, you can still press Ctrl+C 
to copy the selection and then press Ctrl+V when you’re ready to paste it. Note, how- ever, that when 
using a hot key combination with the Alt key, you don’t need to keep the Alt key depressed while 
typing the remaining letter(s) as you do when using a shortcut key combo with the Ctrl key. 

 

Customizing The Quick Access Toolbar 
When you start using Excel, the Quick Access toolbar contains only the following few buttons: 

✓ Save to save any changes made to the current workbook using the same filename, file format, and 
location 

✓ Undo to undo the last editing, formatting, or layout change you made  
✓ Redo to reapply the previous editing, formatting, or layout change that you just removed with the 
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Undo button 
 

The Quick Access toolbar is very customizable because Excel makes it easy to add any Ribbon 
command to it. Moreover, you’re not restricted to adding buttons for just the commands on the 
Ribbon; you can add any Excel command you want to the toolbar, even the obscure ones that don’t 
rate an appearance on any of its tabs. 

 
By default, the Quick Access toolbar appears above the Ribbon tabs immediately to the right of the 

Excel program button (used to resize the workbook window or quit the program). To display the 
toolbar beneath the Ribbon immediately above the Formula bar, click the Customize Quick Access 
Toolbar button (the drop-down button to the right of the toolbar with a horizontal bar above a down-
pointing triangle) and then click Show Below the Ribbon on its drop-down menu. You will definitely 
want to make this change if you start adding more buttons to the toolbar so that the growing Quick 
Access toolbar doesn’t start crowding the name of the current workbook that appears to the toolbar’s 
right. 
 

Adding Command Buttons on The Customize 
Quick Access Toolbar’s Drop-Down Menu 

When you click the Customize Quick Access Toolbar button, a drop-down menu appears 
containing the following commands: 
✓ New to open a new workbook 
✓ Open to display the Open dialog box for opening an existing workbook 
✓ Save to save changes to your current workbook 
✓ E-mail to open your mail 
✓ Quick Print to send the current worksheet to your default printer 
✓ Print Preview to open the Print settings in Backstage View with a pre- view of the current 

worksheet in the right pane 
✓ Spelling to check the current worksheet for spelling errors 
✓ Undo to undo your latest worksheet edit 
✓ Redo to reapply the last edit that you removed with Undo 
✓ Sort Ascending to sort the current cell selection or column in A to Z alphabetical order, lowest 

to highest numerical order, or oldest to newest date order 
✓ Sort Descending to sort the current cell selection or column in Z to A alphabetical order, highest 

to lowest numerical order, or newest to oldest date order. 
 

Adding Command Buttons on The Ribbon 
To add a Ribbon command to the Quick Access toolbar, simply right-click its command button on 

the Ribbon and then click Add to Quick Access Toolbar on its shortcut menu. Excel then immediately 
adds the command button to the very end of the Quick Access toolbar, immediately in front of the 
Customize Quick Access Toolbar button. 

 

If you want to move the command button to a new location on the Quick Access toolbar or group it 
with other buttons on the toolbar, click the Customize Quick Access Toolbar button and then click the 
More Commands option near the bottom of its drop-down menu. Excel then opens the Excel Options 
dialog box with the Quick Access Toolbar tab selected similar to the one shown in the figure bellow. 
On the right side of the dialog box, Excel shows all the buttons added to the Quick Access toolbar.  

 
The order in which they appear from left to right on the toolbar corresponds to the top-down order 
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in the list box. 

 

Formula Bar 
The Formula bar displays the cell address (determined by a column letter(s) followed by a row 

number) and the contents of the current cell. For example, cell A1 is the first cell of each worksheet at 
the intersection of column A and row 1; cell XFD1048576 is the last cell of each worksheet at the 
intersection of column XFD and row 1048576. The type of entry you make determines the contents of 
the current cell: text or numbers, for example, if you enter a heading or particular value, or the details 
of a formula if you enter a calculation. 

 

The Formula bar has three sections: 
✓  Name box: The left-most section that displays the address of the current cell address. 
✓ Formula bar buttons: The second, middle section that appears as a rather nondescript button 

displaying only an indented circle on the left (used to narrow or widen the Name box) and the 
Insert Function button (labeled fx) on the right. When you start making or editing a cell entry, 
Cancel (an X) and Enter (a check mark) buttons appear between them. 

✓ Cell contents: The third, right-most white area to the immediate right of the Insert Function 
button takes up the rest of the bar and expands as necessary to display really long cell entries that 
won’t fit in the normal area. 

 

The cell contents section of the Formula bar is important because it always shows you the 
contents of the cell even when the worksheet does not. (When you’re dealing with a formula, excel 



	

	

Page 7 

	

 

.   CS 1 Department of biology - college of science - University of BAghdAd,, ,  

Computer Science Microsoft Excel Spreadsheet By: Saif Basheer Alkhoja 

	

Second Stage 

displays only the calculated result in the cell in the worksheet and not the formula by which that result 
is derived.) Additionally, you can edit the contents of the cell in this area at anytime. Similarly, when 
the cell contents area is blank, you know that the cell is empty as well. 

 
 

What to Do in The Worksheet Area 
The Worksheet area is where most of the Excel spreadsheet action takes place because it’s the 

place that displays the cells in different sections of the current worksheet and it’s right inside the cells 
that you do all your spread- sheet data entry and formatting, not to mention a great deal of your 
editing. 

 

To enter or edit data in a cell, that cell must be current. Excel indicates that a cell is current in 
three ways: 
✓ The cell cursor — the dark black border surrounding the cell’s entire perimeter — appears in the 

cell. 
✓ The address of the cell appears in the Name box of the Formula bar. 
✓ The cell’s column letter(s) and row number are shaded (in a kind of an orange-beige color on most 

monitors) in the column headings and row headings that appear at the top and left of the 
Worksheet area, respectively. 

 
 

Moving Around The Worksheet 
An Excel worksheet contains far too many columns and rows for all a work- sheet’s cells to be 

displayed at one time regardless of how large your personal computer monitor screen is or how high 
the screen resolution. (After all, we’re talking 17,179,869,184 cells total!) Therefore, Excel offers 
many methods for moving the cell cursor around the worksheet to the cell where you want to enter 
new data or edit existing data: 

 

✓ Click the desired cell — assuming that the cell is displayed within the section of the sheet visible in 
the Worksheet area. 
Click the Name box, type the address of the desired cell, and then press the Enter key. 

✓ Press F5 to open the Go To dialog box, type the address of the desired cell into its Reference text 
box, and then click OK. 

✓ Use the cursor keys, as shown in Table 1-1, to move the cell cursor to the desired cell. 
✓ Use the horizontal and vertical scroll bars at the bottom and right edge of the Worksheet area to 

move the part of the worksheet that contains the desired cell and then click the cell to put the cell 
cursor in it. 

 

Keystroke Shortcuts for Moving The Cell Cursor 
Excel offers a wide variety of keystrokes for moving the cell cursor to a new cell. When you use 

one of these keystrokes, the program automatically scrolls a new part of the worksheet into view, if 
this is required to move the cell pointer. In the table bellow summarize these keystrokes; including 
how far each one moves the cell pointer from its starting position. 
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Surfing The Sheets in a Workbook 
Each new workbook you open in excel contains three blank worksheets, each with its own 16,384 

columns and 1,048,576 rows (giving you a truly staggering 51,539,607,552 blank cells!). But, that’s 
not all. If ever you need more worksheets in your workbook, you can add them simply by clicking the 
Insert Worksheet button that appears to the immediate right of the last sheet tab see the figure bellow 
or by pressing Shift+F11. 

 

Showing Off The Status Bar 
The Status bar is the last component at the very bottom of the Excel program window see the 

figure bellow. The Status bar contains the following: 
✓ Mode indicator that shows the current state of the Excel program ( Ready, Edit, and so on ) as 

well as any special keys that are engaged (Caps Lock, Num Lock, and Scroll Lock). 
✓ Auto Calculate indicator that displays the average and sum of all the numerical entries in the 

current cell selection along with the count of every cell in the selection. 
✓ Layout selector that enables you to select between three layouts for the Worksheet area: Normal, 

the default view that shows only the worksheet cells with the column and row headings; Page 
Layout View that adds rulers, page margins, and shows page breaks for the worksheet; and Page 
Break Preview that enables you to adjust the paging of a report. 

✓ Zoom slider that enables you to zoom in and out on the cells in the Worksheet area by dragging 
the slider to the right or left, respectively. 
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Table of Some Shortcuts in Excel 

 
Finding The Formatting Toolbar Buttons 
Equivalents 
 

Finding the excel equivalents for the buttons on the Formatting toolbar in earlier versions of Excel 
couldn’t be easier: Every one of the buttons on the Formatting toolbar is displayed prominently on the 
Home tab of the Ribbon. They’re all easy to identify because they use the same icons as before and are 
located in the Font, Alignment, or Number group on the Home tab. 

 

In addition to the Font, Font Size, Bold, Italic, Underline, Borders, Fill Color, and Font Color 
buttons from the Formatting toolbar, the Font group also contains the following two buttons: 

 

✓ Increase Font Size button that bumps up the current font size a point. 
✓ Decrease Font Size button that reduces the current font size by a point. 
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In addition to the Left Align, Center, Right Align, Decrease Indent, Increase Indent, and Merge & 
Center buttons, the Alignment group also contains the following buttons: 
✓ Top Align button that vertically aligns the data entered into the current cell selection with the 

top edge of the cell. 
✓ Middle Align button that vertically centers the data entered into the current cell selection. 
✓ Bottom Align button that aligns the data entered in the current cell selection with the bottom 

edge of the cell. 
✓ Orientation button that opens a pop-menu of orientation options that enable you to change the 

direction of the text entered into the current cell selection (by angling it up or down, converting 
it to vertical text, or rotating it up or down) and open the Alignment tab of the Format Cells 
dialog box. 

✓ Wrap Text button that applies wrap text to the current cell selection so that Excel expands the 
row heights as needed to fit all its text within the current column widths. 

 

In addition to the Percent Style, Comma Style, Increase Decimal, and Decrease Decimal buttons 
from the Formatting toolbar, the Numbers group contains the following buttons: 
✓ Accounting Number Format button that enables you to select among several different 

currency formats from U.S. dollars to Swiss Francs, as well as to open the Number tab of the 
Format Cells dialog box with the Accounting number format selected. 

✓ Number Format button that opens a pop-up menu of different number options from General 
through Text, as well as opens the Number tab in the Format Cells dialog box when you select 
its More Number Formats option. 
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Creating a Spreadsheet From Scratch 
 
In this lecture: 
 

Ø  Starting a new workbook 
Ø  Entering the three different types of data in a worksheet 
Ø  Creating simple formulas by hand 
Ø  Fixing your data-entry boo-boos 
Ø  Using the AutoCorrect feature 
Ø  Using the AutoFill feature to complete a series of entries 
Ø  Entering and editing formulas containing built-in functions 
Ø  Totaling columns and rows of numbers with the AutoSum button 
Ø  Saving your precious work and recovering workbooks after a computer crash 

 
After you know how to launch Excel, it’s time to find out how not to get yourself into trouble 

when actually using it! In this lecture, you find out how to put all kinds of information into all those 
little, blank worksheet cells. Here you find out about the Excel AutoCorrect and AutoComplete 
features and how they can help cut down on errors and speed up your work. You also get some basic 
pointers on other smart ways to minimize the drudgery of data entry, such as filling out a series of 
entries with the AutoFill feature and entering the same thing in a bunch of cells all at the same time. 

 
After discovering how to fill up a worksheet with all this raw data, you find out what has to be the 

most important lesson of all — how to save all that information on disk so that you don’t ever have to 
enter the stuff again! 

 

Doing The Data-Entry Thing 
Begin by reciting (in unison) the basic rule of worksheet data entry. All together now: 
 

To enter data in a worksheet, position the cell pointer in the cell where you want the data and then 
begin typing the entry. 
 

Before you can position the cell pointer in the cell where you want the entry, Excel must be in 
Ready mode (look for Ready as the Mode indicator at the beginning of the Status bar). When you start 
typing the entry, however, Excel goes through a mode change from Ready to Enter mode (and Enter 
replaces Ready as the Mode indicator). 

 

If you’re not in Ready mode, try pressing Esc. 
 

As soon as you begin typing in Enter mode, the characters that you type in a cell in the worksheet 
area simultaneously appear on the Formula bar near the top of the screen. Typing something in the 
current cell also triggers a change to the Formula bar because two new buttons, Cancel and Enter, 
appear between the Name box drop-down button and the Insert Function button. 

 

As you continue to type, Excel displays your progress on the Formula bar and in the active cell in 
the worksheet see the figure bellow. However, the insertion point (the flashing vertical bar that acts as 
your cursor) displays only at the end of the characters displayed in the cell. 
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After you finish typing your cell entry, you still have to get it into the cell so that it stays put. 

When you do this, you also change the program from Enter mode back to Ready mode so that you can 
move the cell pointer to another cell and, perhaps, enter or edit the data there. 

 

To complete your cell entry and, at the same time, get Excel out of Enter mode and back into 
Ready mode, you can click the Enter button on the Formula bar, press the Enter key, or press one of 
the arrow keys (↓, ↑, →, or ←) to move to another cell. You can also press the Tab key or Shift+Tab 
keys to complete a cell entry. 

 

Now, even though each of these alternatives gets your text into the cell, each does something a 
little different afterward, so please take note: 

 

✓ If you click the Enter button (the one with the check mark) on the Formula bar, the text goes into 
the cell, and the cell pointer just stays in the cell containing the brand-new entry. 

✓ If you press the Enter key on your keyboard, the text goes into the cell, and the cell pointer moves 
down to the cell below in the next row. 

✓ If you press one of the arrow keys, the text goes into the cell, and the cell pointer moves to the next 
cell in the direction of the arrow. Press ↓, and the cell pointer moves below in the next row just as it 
does when you finish off a cell entry with the Enter key. Press → to move the cell pointer right to 
the cell in the next column; press ← to move the cell pointer left to the cell in the previous column; 
and press ↑ to move the cell pointer up to the cell in the next row above. 

✓ If you press Tab, the text goes into the cell, and the cell pointer moves to the adjacent cell in the 
column on the immediate right (the same as pressing the → key). If you press Shift+Tab, the cell 
pointer moves to the adjacent cell in the column on the immediate left (the same as pressing the ← 
key) after putting in the text. 

 
No matter which of the methods you choose when putting an entry in its place, as soon as you 

complete your entry in the current cell, Excel deactivates the Formula bar by removing the Cancel and 
Enter buttons. Thereafter, the data you entered continues to appear in the cell in the worksheet (with 
certain exceptions that I discuss later in this chapter), and every time you put the cell pointer into that 
cell, the data will reappear on the Formula bar as well. 

 

If, while still typing an entry or after finishing typing but prior to completing the entry, you realize 
that you’re just about to stick it in the wrong cell, you can clear and deactivate the Formula bar by 
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clicking the Cancel button (the one with the X in it) or by pressing Esc. If, however, you don’t realize 
that you had the wrong cell until after you enter your data there, you have to either move the entry to 
the correct cell or delete the entry and then reenter the data in the correct cell. 

 

The Telltale Signs of Text 
A text entry is simply an entry that Excel can’t pigeonhole as either a formula or value. This makes 

text the catchall category of Excel data types. As a practical rule, most text entries (also known as 
labels) are a combination of letters and punctuation or letters and numbers. Text is used mostly for 
titles, headings, and notes in the worksheet. 

 

You can tell right away whether Excel has accepted a cell entry as text because text entries 
automatically align at the left edge of their cells. If the text entry is wider than the cell can display, the 
data spills into the neigh- boring cell or cells on the right, as long as those cells remain blank see the 
figure bellow. 

 

 
If, sometime later, you enter information in a cell that contains spillover text from a cell to its left, 

Excel cuts off the spillover of the long text entry see the figure bellow. Not to worry: Excel doesn’t 
actually lop these characters off the cell entry — it simply shaves the display to make room for the 
new entry. To redisplay the seemingly missing portion of the long text entry, you have to widen the 
column that contains the cell where the text is entered. 
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How Excel Evaluates its Values 
Values are the building blocks of most of the formulas that you create in Excel. As such, values 

come in two flavors: numbers that represent quantities (14 stores or $140,000 dollars) and numbers 
that represent dates (July 30, 1995) or times (2 p.m.). 

 

You can tell whether Excel has accepted your entry as a value because values automatically align 
at the right edge of their cells. If the value that you enter is wider than the column containing the cell 
can display, Excel automatically converts the value to (of all things) scientific notation. To restore a 
value that’s been converted into that weird scientific notation stuff to a regular number, simply widen 
the column for that cell. 

 

Making Sure That Excel’s Got Your Number 
When building a new worksheet, you’ll probably spend a lot of your time entering numbers, 

representing all types of quantities from money that you made (or lost) to the percentage of the office 
budget that went to coffee and donuts. (You mean you don’t get donuts?) 

 

To enter a numeric value that represents a positive quantity, like the amount of money you made 
last year, just select a cell, type the numbers — for example, 459600 — and complete the entry in the 
cell by clicking the Enter button, pressing the Enter key, and so on. To enter a numeric value that rep- 
resents a negative quantity, such as the amount of money the office spent on coffee and donuts last 
year, begin the entry with the minus sign or hyphen (–) before typing the numbers and then complete 
the entry. For example, –175 (that’s not too much to spend on coffee and donuts when you just made 
$459,600). 

 

If you’re trained in accounting, you can enclose the negative number (that’s expense to you) in 
parentheses. You’d enter it like this: (175). If you go to all the trouble to use parentheses for your 
negatives (expenses), Excel goes ahead and automatically converts the number so that it begins with a 
minus sign; if you enter (175) in the Coffee and Donut expense cell, Excel spits back –175. 

 
With numeric values that represent dollar amounts, like the amount of money you made last year, you 
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can include dollar signs ($) and commas (,) just as they appear in the printed or hand written numbers 
you’re working from. 

 

Just be aware that when you enter a number with commas, Excel assigns a number format to the 
value that matches your use of commas. Likewise, when you preface a financial figure with a dollar 
sign, Excel assigns an appropriate dollar-number format to the value (one that automatically inserts 
commas between the thousands). 

 

When entering numeric values with decimal places, use the period as the decimal point. When you 
enter decimal values, the program automatically adds a zero before the decimal point (Excel inserts 
0.34 in a cell when you enter .34) and drops trailing zeros entered after the decimal point (Excel 
inserts 12.5 in a cell when you enter 12.50). 

 

If you don’t know the decimal equivalent for a value that contains a fraction, you can just go ahead 
and enter the value with its fraction. For example, if you don’t know that 2.1875 is the decimal 
equivalent for 23 ⁄ 16, just type 2 3 / 16 (making sure to add a space between the 2 and 3) in the cell. 
After completing the entry, when you put the cell pointer in that cell, you see 23⁄16 in the cell of the 
worksheet, but 2.1875 appears on the Formula bar. As you see in Chapter 3, it’s then a simple trick to 
format the display of 23⁄16 in the cell so that it matches the 2.1875 on the Formula bar. 

 

If you need to enter simple fractions, such as 3 ⁄ 4 or 5 ⁄ 8, you must enter them as a mixed number 
preceded by zero; for example, enter 0 3 / 4 or 0 5 / 8 (be sure to include a space between the zero and 
the fraction). Otherwise, Excel thinks that you’re entering the dates March 4 (3/4) and May 8 (5/8). 

 

When entering in a cell a numeric value that represents a percentage (so much out of a hundred), 
you have this choice: 

 
✓ You can either divide the number by 100 and enter the decimal equivalent (by moving the decimal 

point two places to the left like your teacher taught you; for example, enter .12 for 12 percent). 
✓ You can enter the number with the percent sign (for example, enter 12%). 
 

Either way, Excel stores the decimal value in the cell (0.12 in this example). If you use the percent 
sign, Excel assigns a percentage-number format to the value in the worksheet so that it appears as 
12%. 

 

How to Fix Your Decimal Places (when you don’t 
even know they’re broken) 
 

If you find that you need to enter a whole slew of numbers that use the same number of decimal 
places, you can turn on Excel’s Fixed Decimal setting and have the program enter the decimals for 
you. This feature really comes in handy when you have to enter hundreds of financial figures that all 
use two decimal places (for example, for the number of cents). 

 

To fix the number of decimal places in a numeric entry, follow these steps: 
1.  Choose File ➪ Options ➪ Advanced. 

The Advanced tab of the Excel Options dialog box opens. 
 

2.  Click the Automatically Insert a Decimal Point check box in the Editing Options section to fill it 
with a check mark. 

 

By default, Excel fixes the decimal place two places to the left of the last number you type. To change the 
default Places setting, go to Step 3; otherwise move to Step 4. 

 
3.  (Optional) Type a new number in the Places text box or use the spinner buttons to change the 

value. 
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For example, you could change the Places setting to 3 to enter numbers with the following 
decimal placement: 00.000. 

 

4.  Click OK or press Enter. 
 

Excel displays the Fixed Decimal status indicator on the Status bar to let you know that the 
Fixed Decimal feature is now active. 
 

After fixing the decimal place in numeric values, Excel automatically adds a decimal point to any 
numeric value that you enter using the number of places you selected; all you do is type the digits and 
complete the entry in the cell. For example, to enter the numeric value 100.99 in a cell after fixing the 
decimal point to two places, type the digits 10099 without adding any period for a decimal point. 
When you complete the cell entry, Excel automatically inserts a decimal point two places from the 
right in the number you typed, leaving 100.99 in the cell. 

 

When you’re ready to return to normal data entry for numerical values (where you enter any 
decimal points yourself), open the Advanced tab of the Excel Options dialog box, click the 
Automatically Insert a Decimal Point check box again, this time to clear it, and then click OK or press 
Enter. Excel removes the Fixed Decimal indicator from the Status bar. 
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Tapping on The Old Ten-Key 
 

You can make the Fixed Decimal feature work even better by selecting the block of cells where 
you want to enter numbers and then pressing Num-Lock so that you can enter all the data for this cell 
selection from the numeric keypad (à la ten-key adding machine). 

  Using this approach, all you have to do to enter the range of values in each cell is type the 
number’s digits and press Enter on the numeric keypad. Excel inserts the decimal point in the proper 
place while it moves the cell pointer down to the next cell. Even better, when you finish entering the 
last value in a column, pressing Enter automatically moves the cell pointer to the cell at the top of the 
next column in the selection. 

 

Look at the two figures bellow to see how you can make the ten-key method work for you. In first 
figure, the Fixed Decimal feature is turned on (using the default of two decimal places), and the block 
of cells from B3 through D9 are selected. You also see that six entries have already been made in cells 
B3 through B8 and a seventh, 30834.63, is about to be completed in cell B9. To make this entry when 
the Fixed Decimal feature is on, you simply type 3083463 from the numeric keypad. 

 
 

In the second figure, check out what happens when you press Enter (on either the regular keyboard 
or the numeric keypad). Not only does Excel automatically add the decimal point to the value in cell 
B9, but it also moves the cell pointer up and over to cell C3 where you can continue entering the 
values for this column. 
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Fabricating Those Fabulous Formulas! 
As entries go in Excel, formulas are the real workhorses of the worksheet. 
If you set up a formula properly, it computes the correct answer when you enter the formula into a 

cell. From then on, the formula stays up to date, recalculating the results whenever you change any of 
the values that the formula uses. 

 
You let Excel know that you’re about to enter a formula (rather than some text or a value), in the 

current cell by starting the formula with the equal sign (=). Most simple formulas follow the equal sign 
with a built-in function, such as SUM or AVERAGE. (See the section “Inserting a function into a 
formula with the Insert Function button,” later in this chapter, for more information on using functions 
in formulas.) Other simple formulas use a series of values or cell references that contain values 
separated by one or more of the following mathematical operators: 

 

+ (plus sign) for addition 
– (minus sign or hyphen) for subtraction 
* (asterisk) for multiplication 
/  (slash) for division 
^ (caret) for raising a number to an exponential power 

 

For example, to create a formula in cell C2 that multiplies a value entered in cell A2 by a value in cell 
B2, enter the following formula in cell C2: =A2*B2. To enter this formula in cell C2, follow these 
steps: 
 

1.  Select cell C2. 
2.  Type the entire formula =A2*B2 in the cell. 
3.  Press Enter. 

Or 
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1.  Select cell C2. 
2.  Type = (equal sign). 
3.  Select cell A2 in the worksheet by using the mouse or the keyboard. 
 

This action places the cell reference A2 in the formula in the cell as shown in the figure bellow. 
 

 
4.  Type * (Shift+8 on the top row of the keyboard). 

The asterisk is used for multiplication rather than the × symbol you used in school. 
5.  Select cell B2 in the worksheet by using the mouse or the keyboard. 

This action places the cell reference B2 in the formula as shown in the figure bellow. 

 

6.  Click the Enter button to complete the formula entry while keeping the cell pointer in cell 
C2. 
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Excel displays the calculated answer in cell C2 and the formula =A2*B2 in the Formula bar as 
shown in figure bellow. 

 

When you finish entering the formula =A2*B2 in cell C2 of the worksheet, Excel displays 
the calculated result, depending on the values currently entered in cells A2 and B2. The major 
strength of the electronic spreadsheet is the capability of formulas to change their calculated 
results automatically to match changes in the cells referenced by the formulas. 

 

Now comes the fun part: After creating a formula like the preceding one that refers to the 
values in certain cells (rather than containing those values itself), you can change the values in 
those cells, and Excel automatically recalculates the formula, using these new values and 
displaying the updated answer in the worksheet! Using the example shown in Figure 2-8, 
suppose that you change the value in cell B2 from 100 to 50. The moment that you complete this 
change in cell B2, Excel recalculates the formula and displays the new answer, 1000, in cell C2. 

 

Altering The Natural Order of Operations 
Many formulas that you create perform more than one mathematical operation. Excel performs 

each operation, moving from left to right, according to a strict pecking order (the natural order of 
arithmetic operations). In this order, multiplication and division pull more weight than addition and 
sub- traction and, therefore, perform first, even if these operations don’t come first in the formula 
(when reading from left to right). 

 

Consider the series of operations in the following formula: 
 

=A2+B2*C2 
 

If cell A2 contains the number 5, B2 contains the number 10, and C2 contains the number 2, Excel 
evaluates the following formula: 
 

=5+10*2 
 

In this formula, Excel multiplies 10 times 2 to equal 20 and then adds this result to 5 to produce the 
result 25. 

 

If you want Excel to perform the addition between the values in cells A2 and B2 before the program 
multiplies the result by the value in cell C2, enclose the addition operation in parentheses as follows: 
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=(A2+B2)*C2 
 

The parentheses around the addition tell Excel that you want this operation performed before the 
multiplication. If cell A2 contains the number 5, B2 contains the number 10, and C2 contains the 
number 2, Excel adds 5 and 10 to equal 15 and then multiplies this result by 2 to produce the result 30. 

 

In fancier formulas, you may need to add more than one set of parentheses, one within another 
(like the wooden Russian dolls that nest within each other) to indicate the order in which you want the 
calculations to take place. When nesting parentheses, Excel first performs the calculation contained in 
the most inside pair of parentheses and then uses that result in further calculations as the program 
works its way outward. For example, consider the following formula: 

 

    =(A4+(B4–C4))*D4 
 

Excel first subtracts the value in cell C4 from the value in cell B4, adds the difference to the value in 
cell A4, and then finally multiplies that sum by the value in D4. 

 
Without the additions of the two sets of nested parentheses, left to its own devices, Excel would first 
multiply the value in cell C4 by that in D4, add the value in A4 to that in B4, and then perform the 
subtraction. 

 

Don’t worry too much when nesting parentheses in a formula if you don’t pair them properly so 
that you have a right parenthesis for every left parenthesis in the formula. If you do not include a right 
parenthesis for every left one, Excel displays an alert dialog box that suggests the correction needed to 
balance the pairs. If you agree with the program’s suggested correction, you simply click the Yes 
button. However, be sure that you only use parentheses: ( ). Excel balks at the use of brackets — [ ] — 
or braces — { } — in a formula by giving you an Error alert box. 

 

Formula Flub-Ups 
Under certain circumstances, even the best formulas can appear to have freaked out after you get 

them in your worksheet. You can tell right away that a formula’s gone haywire because instead of the 
nice calculated value you expected to see in the cell, you get a strange, incomprehensible message in 
all uppercase letters beginning with the number sign (#) and ending with an exclamation point (!) or, 
in one case, a question mark (?). This weirdness, in the parlance of spreadsheets, is as an error value. 
Its purpose is to let you know that some element — either in the formula itself or in a cell referred to 
by the formula — is preventing Excel from returning the anticipated calculated value. 

 

When one of your formulas returns one of these error values, an alert indicator (in the form of an 
exclamation point in a diamond) appears to the left of the cell when it contains the cell pointer, and the 
upper-left corner of the cell contains a tiny green triangle. When you position the mouse pointer on 
this alert indicator, Excel displays a brief description of the formula error and adds a drop-down 
button to the immediate right of its box. When you click this button, a pop-up menu appears with a 
number of related options. To access online help on this formula error, including suggestions on how 
to get rid of the error, click the Help on This Error item on this pop-up menu. 

 

The worst thing about error values is that they can contaminate other formulas in the worksheet. If 
a formula returns an error value to a cell and a second formula in another cell refers to the value 
calculated by the first formula, the second formula returns the same error value, and so on down the 
line. 
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After an error value shows up in a cell, you have to discover what caused the error and edit the 
formula in the worksheet. In the table bellow, I list some error values that you might run into in a 
worksheet and then explain the most common causes. 

 

 

AutoFill  
Many of the worksheets that you create with Excel require the entry of a series of sequential dates 

or numbers. For example, a worksheet may require you to title the columns with the 12 months, from 
January through December, or to number the rows from 1 to 100. 

 

Excel’s AutoFill feature makes short work of this kind of repetitive task. All you have to enter is 
the starting value for the series. In most cases, AutoFill is smart enough to figure out how to fill out 
the series for you when you drag the fill handle to the right (to take the series across columns to the 
right) or down (to extend the series to the rows below). 

 

 The AutoFill handle looks like this — + — and appears only when you posi- tion the mouse 
pointer on the lower-right corner of the active cell (or the last cell, when you’ve selected a block of 
cells). If you drag a cell selection with the white cross mouse pointer rather than the AutoFill handle, 
Excel simply extends the cell selection to those cells you drag through. 

 

If you drag a cell selection with the arrowhead pointer, Excel moves the cell selection. When 
creating a series with the fill handle, you can drag in only one direction at a time. For example, you 
can fill the series or copy the entry to the range to the left or right of the cell that contains the initial 
values, or you can fill the series or copy to the range above or below the cell containing the initial 
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values. You can’t, however, fill or copy the series to two directions at the same time (such as down 
and to the right by dragging the fill handle diagonally). 

 

While you drag the mouse, the program keeps you informed of whatever entry will be entered into 
the last cell selected in the range by displaying that entry next to the mouse pointer (a kind of AutoFill 
tips, if you will). When you release the mouse button after extending the range with the fill handle, 
Excel either creates a series in all of the cells that you select or copies the entire range with the initial 
value. To the right of the last entry in the filled or copied series, Excel also displays a drop-down 
button that contains a shortcut menu of options. You can use this shortcut menu to override Excel’s 
default filling or copying. For example, when you use the fill handle, Excel copies an initial value into 
a range of cells. But, if you want a sequential series, you could do this by selecting the Fill Series 
command on the AutoFill Options shortcut menu. 

 

In the two figures bellow, I illustrate how to use AutoFill to enter a row of months, starting with 
January in cell B2 and ending with June in cell G2. To do this, you simply enter January in cell B2 
and then position the mouse pointer on the fill handle in the lower-right corner of this cell before you 
drag through to cell G2 on the right as shown in the figure bellow. When you release the mouse 
button, Excel fills in the names of the rest of the months (February through June) in the selected cells 
(as shown in Figure 2-12). Excel keeps the cells with the series of months selected, giving you another 
chance to modify the series. (If you went too far, you can drag the fill handle to the left to cut back on 
the list of months; if you didn’t go far enough, you can drag it to the right to extend the list of months 
further. 

 

Also, you can use the options on the AutoFill Options drop-down menu (opened by clicking the 
drop-down button that appears on the fill handle to the right of June) to override the series created by 
default. To have Excel copy January into each of the selected cells, choose Copy Cells on this menu. 
To have the program fill the selected cells with the formatting used in cell B2, you select Fill 
Formatting Only on this menu. To have Excel fill in the series of months in the selected cells without 
copying the format- ting used in cell B2, you select the Fill without Formatting command from this 
shortcut menu. 
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Working With a Spaced Series 
AutoFill uses the initial value that you select (date, time, day, year, and so on) to design the series. 

All the sample series I show in the table bellow change by a factor of one (one day, one month, or one 
number). You can tell AutoFill to create a series that changes by some other value: Enter two sample 
values in neighboring cells that describe the amount of change you want between each value in the 
series. Make these two values the initial selection that you extend with the fill handle.   

 For example, to start a series with Saturday and enter every other day across a row, enter Saturday 
in the first cell and Monday in the cell next door. After selecting both cells, drag the fill handle across 
the cells to the right as far as you need to fill out a series based on these two initial values. When you 
release the mouse button, Excel follows the example set in the first two cells by entering every other 
day (Wednesday to the right of Monday, Friday to the right of Wednesday, and so on). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



	

	

Page 26 

	

 

.   CS 1 Department of biology - college of science - University of BAghdAd,, ,  

Computer Science Microsoft Excel Spreadsheet By: Saif Basheer Alkhoja 

	

Second Stage 

Copying With AutoFill  
You can use AutoFill to copy a text entry throughout a cell range (rather than fill in a series of 

related entries). To copy a text entry to a cell range, hold down the Ctrl key while you click and drag 
the Fill handle. When you hold down the Ctrl key while you click the fill handle, a plus sign appears 
to the right of the Fill handle — your sign that AutoFill will copy the entry in the active cell instead of 
creating a series using it. You can also tell because the entry that appears as the AutoFill tip next to the 
mouse pointer while you drag contains the same text as the original cell. If you decide after copying an 
initial label or value to a range that you should have used it to fill in a series, click the drop-down 
button that appears on the fill handle at the cell with the last copied entry and then select the Fill Series 
command on the AutoFill Options shortcut menu that appears.   

  Although holding down Ctrl while you drag the fill handle copies a text entry, just the opposite is 
true when it comes to values! Suppose that you enter the number 17 in a cell and then drag the fill 
handle across the row — Excel just copies the number 17 in all the cells that you select. If, however, 
you hold down Ctrl while you drag the fill handle, Excel then fills out the series (17, 18, 19, and so 
on). If you forget and create a series of numbers when you only need the value copied, rectify this 
situation by selecting the Copy Cells command on the AutoFill Options shortcut menu. 

 
 

Inserting a Function into a Formula With The Insert 
Function Button  

Although you can enter a function by typing it directly in a cell, Excel pro- vides an Insert 
Function button on the Formula bar you can use to select any of Excel’s functions. When you click 
this button, Excel opens the Insert Function dialog box shown in the figure bellow where you can 
select the function you want to use. After you select your function, Excel opens the Function 
Arguments dialog box. In this dialog box, you can specify the function arguments. The real boon 
comes when you’re fooling with an unfamiliar function or one that’s kind of complex (some of these 
puppies can be hairy).  

 

You can get loads of help in completing the argument text boxes in the Function Arguments dialog 
box by clicking the Help on This Function link in the lower- left corner. 
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The Insert Function dialog box contains three boxes: a Search for a Function text box, an Or Select 
a Category drop-down list box, and a Select a Function list box. When you open the Insert Function 
dialog box, Excel automatically selects Most Recently Used as the category in the Select a Category 
drop- down list box and displays the functions you usually use in the Select a Function list box. 

 

If your function isn’t among the most recently used, you must then select the appropriate category 
of your function in the Select a Category drop-down list box. If you don’t know the category, you 
must search for the function by typing a description of its purpose in the Search for a Function text 
box and then press Enter or click the Go button. For example, to locate all the Excel functions that 
total values, you enter total in the Search for Function list box and click the Go button. Excel then 
displays its list of recommended functions for calculating totals in the Select a Function list box. You 
can peruse the recommended functions by selecting each one. While you select each function in this 
list, the Insert Function dialog box shows you the required arguments followed by a description, at the 
bottom of the dialog box, of what the function does. 

 

After you locate and select the function that you want to use, click the OK button to insert the 
function into the current cell and open the Function Arguments dialog box. This dialog box displays 
the required arguments for the function along with any that are optional. For example, suppose that 
you select the SUM function (the crown jewel of the Most Recently Used function category) in the 
Select a Function list box and then click OK. As soon as you do, the program inserts SUM() in the 
current cell and on the Formula bar (following the equal sign), and the Function Arguments dialog box 
showing the SUM arguments appears on the screen (as shown in Figure 2-16). This is where you add 
the arguments for the SUM function. 

 
As shown the figure up, you can sum up to 255 numbers in the Function Arguments dialog box. 

What’s not obvious, however (there’s always some trick, huh?), is that these numbers don’t have to be 
in single cells. In fact, most of the time you’ll be selecting a whole slew of numbers in nearby cells (in 
a multiple cell selection — that range thing) that you want to total. 

 
To select your first number argument in the dialog box, you click the cell (or drag through the 

block of cells) in the worksheet while the insertion point is in the Number1 text box. Excel then 
displays the cell address (or range address) in the Number1 text box while, at the same time, showing 
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the value in the cell (or values, if you select a bunch of cells) in the box to the right. Excel displays the 
total near the bottom of the Function Arguments dialog box after the words Formula result=. 

 

When selecting cells, you can minimize this arguments dialog box to just the contents of the 
Number1 text box by dragging the cell pointer through the cells to sum in the worksheet. After you 
minimize the arguments dialog box while selecting the cells for the first argument, you can then 
expand it again by releasing the mouse button. 

 

You can also reduce the dialog box to the Number1 argument text box by clicking the Minimize 
Dialog Box button on the right of the text box, selecting the cells, and then clicking the Maximize 
Dialog Box button (the only button displayed on the far right) or by pressing the Esc key. Instead of 
minimizing the dialog box, you can also temporarily move it out of the way by clicking on any part 
and then dragging the dialog box to its new destination on the screen.    

  If you’re adding more than one cell (or bunch of cells) in a worksheet, press the Tab key or click 
the Number2 text box to move the insertion point to that text box. (Excel responds by extending the 
argument list with a Number3 text box.) Here is where you specify the second cell (or cell range) to 
add to the one now showing in the Number1 text box. After you click the cell or drag through the 
second cell range, the program displays the cell address(es), the numbers in the cell(s) to the right, and 
the running total near the bottom of the Function Arguments dialog box after Formula result= as 
shown in the last figure before. You can minimize the entire Function Arguments dialog box down to 
just the contents of the argument text box you’re dealing with (Number2, Number3, and so on) by 
clicking its particular Minimize Dialog Box button if the dialog box obscures the cells that you need to 
select. 

 

When you finish pointing out the cells or bunch of cells to sum, click the OK button to close the 
Function Arguments dialog box and put the SUM function in the current cell. 

 

I’d be Totally Lost Without AutoSum 
Before leaving this fascinating discussion on entering functions, I want you to get to the AutoSum 

tool in the Editing group on the Home tab of the Ribbon. 
 

Look for the Greek sigma (Σ) symbol. This little tool is worth its weight in gold. In addition to 
entering the SUM, AVERAGE, COUNT, MAX, or MIN functions, it also selects the most likely range 
of cells in the current column or row that you want to use as the function’s argument and then 
automatically enters them as the function’s argument. Nine times out of ten, Excel selects (with the 
marquee or moving dotted line) the correct cell range to total, average, count, and so forth. For that 
tenth case, you can manually correct the range by simply dragging the cell pointer through the block of 
cells to sum. 

 

Simply click the AutoSum button on the Home tab when you want to insert the SUM function into 
the current cell. If you want to use this button to insert another function, such as AVERAGE, COUNT, 
MAX, or MIN, you need to click its drop-down button and select the name of the desired function on its 
pop-up menu (click Count Numbers on the menu to insert the COUNT function). If you select the More 
Functions command on this menu, Excel opens the Insert Function dialog box as though you had 
clicked the fx button on the Formula bar. 

 

In the figure bellow, check out how to use the AutoSum tool to total the sales of Jack Sprat Diet 
Centers in row 3. Position the cell pointer in cell E3 where the first-quarter total is to appear and then 
click the AutoSum tool. Excel inserts SUM (equal sign and all) onto the Formula bar; places a marquee 
around the cells B3, C3, and D3; and uses the cell range B3:D3 as the argument of the SUM function. 
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Now look at the worksheet after you insert the function in cell E3 (see Figure 2-18). The calculated 
total appears in cell E3 while the following SUM function formula appears in the Formula bar: 

 

=SUM(B3:D3) 
 

 

After entering the function to total the sales of Jack Sprat Diet Centers, you can copy this formula 
to total sales for the rest of the companies by dragging the fill handle down column E until the cell 
range E3:E10 is highlighted. 

 

Look at the figure bellow to see how you can use the AutoSum tool to total the January sales for all 
the Mother Goose Enterprises in column B. Position the cell pointer in cell B10 where you want the 
total to appear. Click the AutoSum tool, and Excel places the marquee around cells B3 through B9 and 
correctly enters the cell range B3:B9 as the argument of the SUM function. 
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In the figure bellow, you see the worksheet after inserting the function in cell B10 and using the 
AutoFill feature to copy the formula to cells C10 and D10 to the right. To use AutoFill, drag the fill 
handle through the cells to the right until you reach cell D10. Release the mouse button. 

 

The Save As Dialog Box in Windows 
The figure bellow shows you the Save As dialog box as it appears in excel when running the 

program under Windows. Here, you can replace the temporary filename (Book1, Book2, and so on) 
with a more descriptive name by clicking the File Name text box and typing in the new name (up to 
255 characters total, including spaces). 
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To select a new folder in which to save the new workbook file, follow these steps: 
 

1.  In the Navigation Pane, click the name of the folder in the Favorites, Libraries, Computer, or 
Network section in which you want to save the workbook file.   

  2.  To save the workbook file within a subfolder of one of the folders now displayed in the main 
pane of the Save As dialog box, double-click its folder icon to open it up. 

 

3.  (Optional) If you want to save the workbook file inside a new sub- folder within the folder 
currently open in the Save As dialog box, click the New Folder button on the toolbar, replace the 
suggested New Folder name by typing the actual name of the folder, and then press Enter. 

 

4.  Click the Save button to save the file in the selected folder. 
 

When the Save As dialog box is expanded by clicking the Browse Folders button, you can modify 
the authors or add tags to the new workbook file by clicking the Add an Author or Add a Tag text 
boxes. You can then use this information later when searching for the workbook. 

 

The Difference Between The XLSX & XLS File 
Format  

Excel 2010, 2013, 2016, 2019 supports the use of the XML-based file format first introduced in 
Excel 2007 (which Microsoft officially calls the Microsoft Office Open XML format). This default 
file format is touted as being more efficient in saving data resulting in smaller file size and offering 
superior integration with external data sources (especially, when these resources are Web-based ones 
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supporting XML files). This XML-based file format carries the filename extension .xlsx and is the file 
format in which Excel automatically saves any new workbook you create. 

 

The only problem with this newfangled XML-based file format is that it can’t be opened by earlier 
Excel versions (before Excel 2007). Therefore, if someone who needs to work with the workbook 
you’ve just created isn’t using Excel 2007 or hasn’t yet upgraded to Excel 2010, you need to save the 
new workbook in the earlier file format used in Excel versions 97 through 2003 with the old .xls 
filename extension. 

 

To do this, click the Save As Type drop-down button in the Save As dialog box and then click 
Excel 97-2003 Workbook (*.xls) on the drop-down menu. (If you work in an office where all 
workbooks must be backwardly compatible with earlier versions. 

 

Filename extensions, such as .xlsx and .xls, do not appear as part of the filename (even though they 
are appended) in the File Name text box in the Excel Save As dialog box unless you’ve specifically 
changed Windows’ folder options to show them. To make this change, open the Folder Options dialog 
box in Windows Explorer and then deselect the Hide Extensions for Known File Types check box on 
the View tab. To open the Folder Options dialog box, select Tools�Options on the Explorer window’s 
pull-down menus in Windows XP or click the Organize button and then select Folder and Search 
Options on its drop-down menu in Windows. 

 

Excel 2010 up to Excel 2019 also supports a special binary file format called Excel Binary 
Workbook that carries the .xlsb filename extension. Select this binary format for huge spreadsheets 
that you create that have to be compatible with earlier versions of Excel. 

 

Saving The Workbook as a PDF File 
The PDF (Portable Document File) file format developed by Adobe Systems Incorporated enables 

people to open up and print documents without access to the original programs with which the 
documents were created. 

 

Excel enables you to save your workbook files directly in this special PDF file format. You can 
readily share your Excel workbooks with users who don’t have Excel installed on their computers by 
saving them as PDF files. All they need to open and print the PDF copy of the workbook file is the 
free Adobe Reader software (which they can download from the Adobe Web site at www.adobe.com). 

 

 To save your workbook as a PDF file, you simply select the PDF option on the Save as Type 
drop-down list in the Save As dialog box. Excel then adds PDF- specific options to the bottom of the 
Save As dialog box, with the Standard (Publishing Online and Printing) button under the Optimize For 
heading and the Open File after Publishing check box selected. 

 

If you want to make the resulting PDF file as small as possible (because your worksheet is so 
large), click the Minimum Size (Publishing Online) button under the Optimize For heading. If you 
want to change which parts of the workbook are saved in the resulting PDF (Excel automatically saves 
all ranges in the active worksheet of the workbook), click the Options button directly beneath the 
Minimum Size (Publishing Online) option and make the appropriate changes in the Options dialog 
box before you click OK. 

 

If you don’t need to edit the filename (Excel automatically appends .pdf to the current filename) or 
the folder location in the Save As dialog box, simply click the Save button. Excel then saves a copy of 
the workbook in a PDF file format and, provided you don’t deselect the Open File after Publishing 
check box, automatically opens the workbook for your inspection in Adobe Reader. After viewing the 
PDF version in Adobe Reader, you can then return to your worksheet in Excel by clicking Reader’s 
Close button (or pressing Alt+F4). 

If you create an Excel workbook that incorporates new features not sup- ported in earlier versions 
of Excel, instead of saving the workbook as an .xls file, thereby losing all of its 2010 enhancements, 



	

	

Page 33 

	

 

.   CS 1 Department of biology - college of science - University of BAghdAd,, ,  

Computer Science Microsoft Excel Spreadsheet By: Saif Basheer Alkhoja 

	

Second Stage 

consider saving it as a PDF file. That way, co-workers still using pre-2010 Excel versions can still 
access the data in all its glory via Adobe Reader. 
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Making It  All Look Pretty 
In This Lecture 

 

Ø  Selecting the cells to format 
Ø  Formatting data tables with the Format as Table command button  
Ø  Using various number formats on cells containing values 
Ø  Adjusting column width and row height in a worksheet 
Ø  Hiding columns and rows in a worksheet 
Ø  Formatting cell ranges from the Home tab of the Ribbon 
Ø  Formatting cell ranges using Styles and the Format Painter 
Ø  Formatting cells under certain conditions 

 
In spreadsheet programs like Excel, you normally don’t worry about how the stuff looks until after 

you enter all the data in the worksheets of your workbook and save it all safe and sound. Only then do 
you pretty up the information so that it’s clearer and easy to read. 

 
After you decide on the types of formatting that you want to apply to a portion of the worksheet, 

you can select all the cells to beautify and then click the appropriate tool or choose the menu 
command to apply those formats to the cells. However, before you discover all the fabulous 
formatting features you can use to dress up cells, you need to know how to pick the group of cells that 
you want to apply the formatting to — that is, selecting the cells or, alternately, making a cell 
selection. 

 

Be aware, also, that entering data into a cell and formatting that data are two completely different 
things in Excel. Because they’re separate, you can change the entry in a formatted cell, and new 
entries assume the cell’s for- matting. This enables you to format blank cells in a worksheet, knowing 
that when you get around to making entries in those cells, those entries automatically assume the 
formatting you assign to those cells. 

 

Choosing a Select Group of Cells  
Given the monotonously rectangular nature of the worksheet and its components, it shouldn’t 

come as a surprise to find that all the cell selections you make in the worksheet have the same kind of 
cubist feel to them. After all, worksheets are just blocks of cells of varying numbers of columns and 
rows. 

 

A cell selection (or cell range) is whatever collection of neighboring cells you choose to format or 
edit. The smallest possible cell selection in a worksheet is just one cell: the so-called active cell. The 
cell with the cell cursor is really just a single cell selection. The largest possible cell selection in a 
worksheet is all the cells in that worksheet (the whole enchilada, so to speak). Most of the cell 
selections you need for formatting a worksheet will probably fall somewhere in between, consisting of 
cells in several adjacent columns and rows. 

 

Excel shows a cell selection in the worksheet by highlighting in color the entire block of cells 
within the extended cell cursor except for the active cell that keeps its original color. The figure 
bellow shows several cell selections of different sizes and shapes. 
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In Excel, you can select more than one cell range at a time (a phenomenon somewhat ingloriously 

called a noncontiguous or nonadjacent selection). In fact, although the figure appears to contain 
several cell selections, it’s really just one big, nonadjacent cell selection with cell D12 (the active one) 
as the cell that was selected last. 

 

Point-And-Click Cell Selections 
The mouse is a natural for selecting a range of cells. Just position the mouse pointer (in its thick, 

white cross form) on the first cell and then click and drag in the direction that you want to extend the 
selection. 
✓ To extend the cell selection to columns to the right, drag your mouse to the right, highlighting 

neighboring cells as you go. 
✓ To extend the selection to rows to the bottom, drag your mouse down. 
✓ To extend the selection down and to the right at the same time, drag your mouse diagonally toward 

the cell in the lower-right corner of the block you’re highlighting. 
 

Shifty Cell Selections 
To speed up the old cell-selection procedure, you can use the Shift+click method, which goes as 

follows: 
1.  Click the first cell in the selection. 

This selects that cell. 
2.  Position the mouse pointer in the last cell in the selection. 

This is kitty-corner from the first cell in your selected rectangular block. 
3.  Press the Shift key and hold it down while you click the mouse button again. 

When you click the mouse button the second time, Excel selects all the cells in the columns and 
rows between the first cell and last cell. 
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The Shift key works with the mouse like an extend key to extend a selection from the first object 
you select through to, and including, the second object you select. See the section “Extend that cell 
selection,” later in this chapter. Using the Shift key enables you to select the first and last cells, as well 
as all the intervening cells in a worksheet or all the document names in a dialog list box. 

 

If, when making a cell selection with the mouse, you notice that you include the wrong cells before 
you release the mouse button, you can deselect the cells and resize the selection by moving the pointer 
in the opposite direction. If you already released the mouse button, click the first cell in the 
highlighted range to select just that cell (and deselect all the others) and then start the whole selection 
process again. 

 

Nonadjacent Cell Selections 
To select a nonadjacent cell selection made up of more than one non-touching block of cells, drag 

through the first cell range and release the mouse button. Then hold down the Ctrl key while you click 
the first cell of the second range and drag the pointer through the cells in this range. As long as you 
hold down Ctrl while you select the subsequent ranges, Excel doesn’t deselect any of the previously 
selected cell ranges. 

 

The Ctrl key works with the mouse like an add key to include non-neighboring objects in Excel. 
See the section “Nonadjacent cell selections with the key- board,” later in this chapter. By using the 
Ctrl key, you can add to the selection of cells in a worksheet or to the document names in a dialog list 
box without having to deselect those already selected. 

 

Going for the “big” cell  selections 
You can select the cells in entire columns or rows or even all the cells in the worksheet by 

applying the following clicking-and-dragging techniques to the worksheet frame: 
✓ To select every single cell in a particular column, click its column letter on the frame at the top of 

the worksheet document window. 
✓ To select every cell in a particular row, click its row number on the frame at the left edge of the 

document window. 
✓ To select a range of entire columns or rows, drag through the column letters or row numbers on the 

frame surrounding the workbook. 
✓ To select more than entire columns or rows that are not right next to each other (that old 

noncontiguous stuff, again), press and hold down the Ctrl key while you click the column letters 
or row numbers of the columns and rows that you want to add to the selection. 

✓ To select every cell in the worksheet, press Ctrl+A or click the Select All button, which is the 
button with the triangle pointing downward on the diagonal (reminding me of the corner of a dog-
eared book page). It’s in the upper-left corner of the workbook frame, formed by the intersection 
of the row with the column letters and the column with the row numbers. 

 

Selecting The Cells in a Table of Data, Courtesy of 
AutoSelect 

Excel provides a quick way (called AutoSelect) to select all the cells in a table of data entered as a 
solid block. To use AutoSelect, simply follow these steps: 

 

1.  Click the first cell of the table to select it. 
This is the cell in the table’s upper-left corner. 
 

2.  Hold down the Shift key while you double-click the right or bottom edge of the selected cell 
with the arrowhead mouse pointer, see the figure bellow. 
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Double-clicking the bottom edge of the cell causes the cell selection to expand to the cell in 
the last row of the first column as shown in the figure bellow. If you double-click the right edge 
of the cell, the cell selection expands to the cell in the last column of the first row. 
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3.A.  Double-click somewhere on the right edge of the cell selection I refer to the previous 
figure if the cell selection now consists of the first column of the table. 

 

This selects all the remaining rows of the table of data as shown in the next figure. 
3.B.  Double-click somewhere on the bottom edge of the current cell selection if the cell 

selection now consists of the first row of the table. 
 

This selects all the remaining rows in the table. 

 
Although the preceding steps may lead you to believe that you have to select the first cell of 

the table when you use AutoSelect, you can actually select any of the cells in the four corners of 
the table. Then, when expanding the cell selection in the table with the Shift key depressed, you 
can choose whatever direction you like to either select the first or last row of the table or the first 
or last column. (Choose left, by clicking the left edge; right, by clicking the right edge; up, by 
clicking the top edge; or down, by clicking the bottom edge.) After expanding the cell selection 
to include either the first or last row or first or last column, you need to click whichever edge of 
that current cell selection that will expand it to include all the remaining table rows or columns. 

 

Format As Table Gallery 
Here’s a formatting technique that doesn’t require you to do any prior cell selecting. The Format as 

Table feature is so automatic that the cell cursor just has to be within the table of data prior to you 
clicking the Format as Table command button in the Styles group on the Home tab. Clicking the 
Format as Table command button opens its rather extensive Table gallery with the formatting 
thumbnails divided into three sections — Light, Medium, and Dark — each of which describes the 
intensity of the colors used by its various formats. 

 

As soon as you click one of the table formatting thumbnails in this Table gallery, Excel makes its 
best guess as to the cell range of the data table to apply it to (indicated by the marquee around its 
perimeter) and the Format As Table dialog box, similar to the one shown in the figure bellow. 
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This dialog box contains a Where Is the Data for Your Table text box that shows the address of the 

cell range currently selected by the marquee and a My Table Has Headers check box. If Excel does not 
correctly guess the range of the data table you want to format, drag through the cell range to adjust the 
marquee and the range address in the Where Is the Data for Your Table text box. If your data table 
doesn’t use column headers or, if the table has them, but you still don’t want Excel to add Filter drop-
down buttons to each column heading, deselect the My Table Has Headers check box before you click 
the OK button. 

 

The table formats in the Table gallery are not available if you select multiple nonadjacent cells 
before you click the Format as Table command button on the Home tab. 

 

After you click the OK button in the Format As Table dialog box, Excel applies the format of the 
thumbnail you clicked in the gallery to the data table. Additionally, the Design tab appears under the 
Table Tools contextual tab at the end of the Ribbon, as shown in the figure bellow. 
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The Design tab enables you to use Live Preview to see how your table would appear. Simply 
position the mouse pointer over any of the format thumbnails in the Table Styles group to see the data 
in your table appear in that table format. Click the button with the triangle pointing downward to scroll 
up new rows of table formats in the Table Styles group and the button with the tri- angle pointing 
upward to scroll down rows without opening the Table gallery and possibly obscuring the actual data 
table in the Worksheet area. Click the More button (the one with the horizontal bar above the 
downward pointing triangle) to redisplay the Table gallery and then mouse over the thumbnails in the 
Light, Medium, and Dark sections to have Live Preview apply them to the table.    

 In addition to enabling you to select a new format from the Table gallery in the Table Styles 
group, the Design tab contains a Table Style Options group containing a bunch of check boxes that 
enable you to customize the look of the selected table format even further: 

✓ Header Row to add special formatting and Filter buttons to each of the column headings 
in the first row of the table. 

✓ Total Row to have Excel add a Total Row to the bottom of the table that displays the 
sums of each column that contains values. To apply another Statistical function to the 
values in a particular column, click the cell in that column’s Total Row to display a drop-
down list button and then select the function — Average, Count, Count Numbers, Max, 
Min, Sum, StdDev (Standard Deviation), or Var (Variance). 

✓ First Column to have Excel display the row headings in the first column of the table in 
bold. 

✓ Last Column to have Excel display the row headings in the last column of the table in 
bold. 

✓ Banded Rows to have Excel apply shading to every other row in the table. 
✓ Banded Columns to have Excel apply shading to every other column in the table. 
 

Whenever you assign a format in the Table gallery to one of the data tables in your workbook, 
Excel automatically assigns that table a generic range name (Table1, Table2, and so on). You can use 
the Table Name text box in the Properties group on the Design tab to rename the data table by giving 
it a more descriptive range name. 

 

When you finish selecting and/or customizing the formatting of your data table, click a cell 
outside of the table to remove the Table Tools contextual tab (with its Design tab) from the Ribbon. If 
later, you decide that you want to further experiment with the table’s formatting, click any of the 
table’s cells to redisplay the Table Tools’ Design tab at the end of the Ribbon. 

 

Cell Formatting From The Home Tab 
Some spreadsheet tables or ranges within them require a lighter touch than the Format as Table 

command button offers. For example, you may have a data table where the only emphasis you want to 
add is to make the column headings bold at the top of the table and to underline the row of totals at the 
bottom (done by drawing a borderline along the bottom of the cells). 

 

The formatting buttons that appear in the Font, Alignment, and Number groups on the Home 
tab enable you to accomplish just this kind of targeted cell formatting. The next three figures identify 
all the formatting buttons in these three groups on the Home tab. See the Table bellow the figures for a 
complete rundown on how to use each of these formatting buttons. 
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Don’t forget about these shortcut keys for quickly adding or removing attri- butes from the entries 
in the cell selection: Ctrl+B for toggling on and off bold in the cell selection, Ctrl+I for toggling on 
and off italic, and Ctrl+U for toggling on and off underlining. 

 

Altering The Alignment 
The horizontal alignment assigned to cell entries when you first make them is simply a function of 

the type of entry it is: All text entries are left aligned, and all values are right-aligned with the borders 
of their cells. However, you can alter this standard arrangement anytime it suits you. 

 

The Alignment group of the Home tab contains three normal horizontal alignment tools: the Align 
Left, Center, and Align Right buttons. These buttons align the current cell selection exactly as you 
expect them to. On the right side of the Alignment group, you usually find the special alignment 
button called Merge & Center. 

 

Despite its rather strange name, you’ll want to get to know this button. You can use it to center a 
worksheet title across the entire width of a table in seconds (or faster, depending upon your machine). 
I show you in the figures bellow how you can use this tool. In first figure, notice that the worksheet 
title Mother Goose Enterprises – 2010 Sales is in cell A1. To center this title over the table (which 
extends from column A through E), select the cell range A1:E1 (the width of the table) and then click 
the Merge & Center button in the Alignment group on the Ribbon’s Home tab. 

 
Look at the next figure bellow to see the result: The cells in row 1 of columns A through E are 

merged into one cell, and now the title is properly centered in this “super” cell and consequently over 
the entire table. 
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If you ever need to split up a super cell that you’ve merged with Merge & Center back into its 
original, individual cells, select the cell and then simply click the Merge & Center button in the 
Alignment group on the Home tab again. You can also do this by clicking the drop-down button 
attached to the Merge & Center button on the Home tab and then clicking Unmerge Cells on this drop-
down menu (a few more steps, I’d say!). 

 

Intent on Indents 
In Excel, you can indent the entries in a cell selection by clicking the Increase Indent button. The 

Increase Indent button in the Alignment group of the Home tab sports a picture of an arrow pushing 
the lines of text to the right. Each time you click this button, Excel indents the entries in the current 
cell selection to the right by three character widths of the standard font. You can remove an indent by 
clicking the Decrease Indent button (to the immediate left of the Increase Indent button) on the Home 
tab with the picture of the arrow pushing the lines of text to the left. Additionally, you can change how 
many characters an entry indents with the Increase Indent button (or outdents with the Decrease Indent 
button). Open the Format Cells dialog box (Ctrl+1). Select the Alignment tab, and then alter the value 
in the Indent text box (by typing a new value in this text box or by dialing up a new value with its 
spinner buttons). 

 

From Top to Bottom 
Left, right, and center alignment all refer to the horizontal positioning of a text entry in relation to 

the left and right cell borders (that is, horizontally). You can also align entries in relation to the top and 
bottom borders of their cells (that is, vertically). Normally, all entries align vertically with the bottom 
of the cells (as though they were resting on the very bottom of the cell). You can also vertically center 
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an entry in its cell or align it with the top of its cell. 
 

To change the vertical alignment of a cell range that you’ve selected, click the appropriate button 
(Top Align, Middle Align, or Bottom Align) in the Alignment group on the Home tab.   

 The bellow figure shows the title for the 2010 Mother Goose Enterprises sales worksheet after 
centering it vertically in its cell by clicking the Middle Align button on the Home tab. (This text entry 
was previously centered across the cell range A1:E1; the height of row 1 is increased from the normal 
15 points to 36 points.) 

 

Tampering With How the Text Wraps 
Traditionally, column headings in worksheet tables have been a problem — you had to keep them 

really short or abbreviate them if you wanted to avoid widening all the columns more than the data 
warranted. You can avoid this problem in Excel by using the Wrap Text button in the Alignment 
group on the Home tab (the one to the immediate right of the Orientation button). In the next figure 
bellow, I show a new worksheet in which the column headings containing the various companies 
within the vast Mother Goose Enterprises conglomerate use the Wrap Text feature to avoid widening 
the columns as much as these long company names would otherwise require. 

 

To create the effect shown in the figure bellow, select the cells with the column headings (the cell 
range B2:H2) and then click the Wrap Text button in the Alignment group on the Home tab.   

 Selecting Wrap Text breaks up the long text entries (that either spill over or cut off) in the 
selection into separate lines. To accommodate more than one line in a cell, the program automatically 
expands the row height so that the entire wrapped-text entry is visible. 
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When you select Wrap Text, Excel continues to use the horizontal and vertical alignment you 
specify for the cell. You can use any of the Horizontal alignment options found on the Alignment tab 
of the Format Cells dialog box (Ctrl+1), including Left (Indent), Center, Right (Indent), Justify, or 
Center Across Selection. However, you can’t use the Fill option or Distributed (Indent) option. Select 
the Fill option on the Horizontal drop-down list box only when you want Excel to repeat the entry 
across the entire width of the cell. 

 

If you want to wrap a text entry in its cell and have Excel justify the text with both the left and 
right borders of the cell, select the Justify option from the Horizontal drop-down list box in the 
Alignment tab in the Format Cells dialog box. 

 

 

You can break a long text entry into separate lines by positioning the insertion point in the cell 
entry (or on the Formula bar) at the place where you want the new line to start and pressing Alt+Enter. 
Excel expands the row containing the cell (and the Formula bar above) when it starts a new line. When 
you press Enter to complete the entry or edit, Excel automatically wraps the text in the cell, according 
to the cell’s column width and the position of the line break. 

 

Reorienting Cell Entries 
Instead of wrapping text entries in cells, you may find it more beneficial to change the orientation 

of the text by rotating the text up (in a counterclockwise direction) or down (in a clockwise direction). 
Peruse the figure bellow for a situation where changing the orientation of the wrapped column 
headings works much better than just wrapping them in their normal orientation in the cells. 

 

This example shows the same column headings for the sample order form I introduced in the 
previous figure after rotating them 90 degrees counterclockwise. To make this switch, first select the 
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cell range B2:H2. Next, click the Orientation button in the Alignment group on the Home tab and then 
click the Rotate Text Up option on the drop-down menu. 

 

Fooling Around With The Format Painter 
Using cell styles to format ranges of worksheet cells is certainly the way to go when you have to 

apply the same formatting repeatedly in the workbooks you create. However, there may be times when 
you simply want to reuse a particular cell format and apply it to particular groups of cells in a single 
workbook without ever bothering to open the Cell Styles gallery. 

 

For those occasions when you feel the urge to format on the fly (so to speak), use the Format 
Painter button (the paintbrush icon) in the Clipboard group on the Home tab. This wonderful little tool 
enables you to take the formatting from a particular cell that you fancy up and apply its formatting to 
other cells in the worksheet simply by selecting those cells. 

 

To use the Format Painter to copy a cell’s formatting to other worksheet cells, just follow these 
easy steps: 

 

1.  Format an example cell or cell range in your workbook, selecting whatever fonts, alignment, 
borders, patterns, and color you want it to have. 

 

2.  With the cell cursor in one of the cells you just fancied up, click the Format Painter button in the 
Clipboard group on the Home tab. 

 

The mouse pointer changes from the standard thick, white cross to a thick, white cross with an 
animated paintbrush by its side, and you see a marquee around the selected cell with the formatting 
to be used by the Format Painter. 
 

3.  Drag the white-cross-plus-animated-paintbrush pointer (the Format Painter pointer) through all the 
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cells you want to format. 
 

As soon as you release the mouse button, Excel applies all the formatting used in the example cell to 
all the cells you just selected! 
 

To keep the Format Painter selected so that you can format a bunch of different cell ranges with 
the Format Painter pointer, double-click the Format Painter button on the Home tab after you select 
the sample cell with the desired formatting. To stop formatting cells with the Format Painter pointer, 
you simply click the Format Painter button on the Home tab again (it remains selected when you 
double-click it) to restore the button to its unselected state and return the mouse pointer to its normal 
thick, white cross shape. 

 

You can use the Format Painter to restore a cell range that you gussied all up back to its boring 
default (General) cell format. To do this, click an empty, previously unformatted cell in the worksheet 
before you click the Format Painter button and then use the Format Painter pointer to drag through the 
cells you want returned to the default General format. 

 

Conditional Formatting 
Before leaving behind the scintillating subject of cell formatting, there’s one more formatting 

button in the Styles group of the Home tab of which you need to be aware. The Conditional 
Formatting button enables you to apply provisional formatting to a cell range based solely on the 
categories into which its current values fall. The cool thing about this kind of conditional formatting is 
that should you edit the numbers in the cell range so that their values fall into other categories, the 
program automatically changes their cell formatting to suit. 

 
When you click the Conditional Formatting button in the Styles group of the Home tab, a drop-

down menu appears with the following options: 
 

✓ Highlight Cells Rules opens a continuation menu with various options for defining formatting 
rules that highlight the cells in the cell selection that contain certain values, text, or dates; that have 
values greater or less than a particular value; or that fall within a certain ranges of values. 

✓ Top/Bottom Rules opens a continuation menu with various options for defining formatting rules 
that highlight the top and bottom values, percentages, and above and below average values in the 
cell selection. 

✓ Data Bars opens a palette with different color data bars that you can apply to the cell selection to 
indicate their values relative to each other by clicking the data bar thumbnail. 

 

✓ Color Scales opens a palette with different two- and three-colored scales that you can apply to 
the cell selection to indicate their values relative to each other by clicking the color scale 
thumbnail. 

 

✓ Icon Sets opens a palette with different sets of icons that you can apply to the cell selection to 
indicate their values relative to each other by clicking the icon set. 

 

✓ New Rule opens the New Formatting Rule dialog box where you define a custom conditional 
formatting rule to apply to the cell selection. 

 

✓ Clear Rules opens a continuation menu where you can remove conditional formatting rules for 
the cell selection by clicking the Clear Rules from Selected Cells option, for the entire worksheet 
by clicking the Clear Rules from Entire Sheet option, or for just the current data table by clicking 
the Clear Rules from This Table option. 

 

✓ Manage Rules opens the Conditional Formatting Rules Manager dialog box where you edit and 
delete particular rules as well as adjust their rule precedence by moving them up or down in the 
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Rules list box. 
 

Conditionally Formatting Values With Sets of 
Graphic Scales & Markers 

The easiest conditional formatting that you can apply to a worksheet cell range is using the pop-up 
palettes of graphical scales and markers attached to the Data Bars, Color Scales, and Icon Sets options 
on the Conditional Formatting button’s drop-down menu: 
✓ Data Bars represents the relative values in the cell selection by the length of the color bar in each 

cell and are great for helping you quickly spot the lower and higher values within a large range of 
data. 

✓ Color Scales classify the relative values in a cell selection with a color gradation using a one-, 
two-, or three-color scale and are great for identifying the distribution of values across a large range 
of data. 

✓ Icon Sets classify the values in the cell selection into three to five categories and each icon within 
the set represents a range of values that go from high to low. Icon sets are great for quickly 
identifying the different ranges of values in a range of data. 

 

The figure bellow shows you an example of cell ranges (containing identical values) using each of the 
three formatting types. The values in the first range (B2:B12) are conditionally formatted using blue 
Gradient Fill Data Bars. The values in the second range (D2:D12) are conditionally formatted using 
the Green, Yellow, Red Color Scale. The values in the third range (F2:F12) are conditionally 
formatted using the 3 Arrows Directional Icon set. 

In this figure up, the particular conditional formatting types Excel assigned to each cell range can 



	

	

Page 52 

	

 

.   CS 1 Department of biology - college of science - University of BAghdAd,, ,  

Computer Science Microsoft Excel Spreadsheet By: Saif Basheer Alkhoja 

	

Second Stage 

be interpreted as follows: 
✓ Data bars added to the cells in the first cell range, B2:B12, represent the relative size of its values 

graphically, much like a standard bar chart. 
 

✓ Color scale applied to the second range, D2:D12, represent the relative size of the values in the 
range by color and hue (red hues applied to the lower values, yellow to the middle values, and 
green to the higher values). 

 

✓ Directional icons applied to the third cell range, F2:F12, represent the relative size of the values in 
the range with arrow icons pointing in different directions (arrows pointing straight down for the 
lower values, straight up for the higher values, and sideways for middling values). 

Keeping Pace With Paste Options 
Right after you click the Paste button on the Home tab of the Ribbon or press Ctrl+V to paste cell 

entries that you copy (not cut) to the Clipboard, Excel displays a Paste Options button with the label, 
(Ctrl), to its immediate right at the end of the pasted range. When you click this drop-down button or 
press the Ctrl key, a palette similar to the one shown in the figure bellow appears with three groups of 
buttons (Paste, Paste Values, and Other Paste Options). 

 
You can use these paste options to control or restrict the type of content and formatting that’s 

included in the pasted cell range. The paste options (complete with the hot key sequences you can type 
to select them) on the Paste Options palette include: 
✓ Paste(P): Excel pastes all the stuff in the cell selection (formulas, for- matting, you name it). 
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✓ Formulas (F): Excel pastes all the text, numbers, and formulas in the cur- rent cell selection 
without their formatting. 

✓ Formulas & Number Formatting (O): Excel pastes the number formats assigned to the 
copied values along with their formulas. 

✓ Keep Source Formatting (K): Excel copies the formatting from the origi- nal cells and pastes 
this into the destination cells (along with the copied entries). 

✓ No Borders (B): Excel pastes all the stuff in the cell selection without copying any borders 
applied to its cell range. 

✓ Keep Source Column Widths (W): Excel makes the width of the columns in the destination 
range the same as those in the source range when it copies their cell entries. 

✓ Transpose (T): Excel changes the orientation of the pasted entries. 
 

For example, if the original cells’ entries run down the rows of a single column of the worksheet, 
the transposed pasted entries will run across the columns of a single row. 

✓ Values (V): Excel pastes only the calculated results of any formulas in the source cell range. 
✓ Values & Number Formatting (A): Excel pastes the calculated results of any formulas along 

with all the formatting assigned to the labels, values, and formulas in the source cell range into the 
destination range. This means that all the labels and values in the destination range appear for 
matted just like the source range even though all the original formulas are lost and only the 
calculated values are retained. 

✓ Values & Source Formatting (E): Excel pastes the calculated results of any formulas along 
with all formatting assigned to the source cell range. 

✓ Formatting (R): Excel pastes only the formatting (and not the entries) copied from the source 
cell range to the destination range. 

✓ Paste Link (N): Excel creates linking formulas in the destination range so that any changes that you 
make to the entries in cells in the source range are immediately brought forward and reflected in the 
corresponding cells of the destination range. 

✓ Picture (U): Excel pastes only the pictures in the copied cell selection. 
✓ Linked Picture (I):  Excel pastes a link to the pictures in the copied cell selection. 

 

The options that appear on the Paste Options palette are context sensitive. This means that the 
particular paste options available on the palette depend directly upon the type of cell entries previously 
copied to the Office Clipboard. Additionally, you can access this same palette of paste options by 
clicking the drop-down button that appears directly beneath the Paste button on the Ribbon instead of 
clicking the Paste Options button that appears at the end of the pasted range in the worksheet or 
pressing the Ctrl key on your keyboard. 
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Printing the Masterpiece 
 

In This Lecture 
 

Ø  Previewing pages in Page Layout View and printouts in Backstage View 
Ø  Quick Printing from the Quick Access toolbar 
Ø  Printing all the worksheets in a workbook 
Ø  Printing just some of the cells in a worksheet 
Ø  Changing page orientation 
Ø  Printing the whole worksheet on a single page 
Ø  Changing margins for a report 
Ø  Adding a header and footer to a report 
Ø  Printing column and row headings as print titles on every page of a report 
Ø  Inserting page breaks in a report 
Ø  Printing the formulas in your worksheet 

 
For most people, getting data down on paper is what spreadsheets are all about (all the talk about a 

so-called paperless office to the contrary). Everything — all the data entry, all the formatting, all the 
formula checking, all the things you do to get a spreadsheet ready — is really just preparation for 
printing its information. 

 

In this chapter, you find out just how easy it is to print reports with Excel. Thanks to the program’s 
new Print panel in Backstage View (Alt+FP), its Page Layout worksheet view, and its handy Page 
Layout tab on the Ribbon, you discover how to produce top-notch reports the first time you send the 
document to the printer (instead of the second or even the third time around). 

 

The only trick to printing a worksheet is getting used to the paging scheme and learning how to 
control it. Many of the worksheets you create with Excel are not only longer than one printed page but 
also wider. Word processors, such as Word 2010, page the document only vertically; they won’t let 
you create a document wider than the page size you’re using. Spreadsheet pro- grams like Excel, 
however, often have to break up pages both vertically and horizontally to print a worksheet document 
(a kind of tiling of the print job, if you will). 

 

When breaking a worksheet into pages, Excel first pages the document vertically down the rows in 
the first columns of the print area (just like a word processor). After paging the first columns, the 
program pages down the rows of the second set of columns in the print area. Excel pages down and 
then over until the entire document included in the current print area (which can include the entire 
worksheet or just sections) is paged. 

 

When paging the worksheet, Excel doesn’t break up the information within a row or column. If not 
all the information in a row will fit at the bottom of the page, the program moves the entire row to the 
following page. If not all the information in a column will fit at the right edge of the page, the program 
moves the entire column to a new page. (Because Excel pages down and then over, the column may 
not appear on the next page of the report.) 

 

You can deal with such paging problems in several ways, and in this chapter, you see all of them! 
After you have these page problems under control, printing is a proverbial piece of cake. 
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Printing Just The Current Worksheet 

As long as you want to use Excel’s default print settings to print all the cells in the current 
worksheet, printing in Excel is a breeze. Simply add the Quick Print button to the Quick Access 
toolbar (by clicking the Customize Quick Access Toolbar button and then clicking Quick Print on its 
drop-down menu). 

 

After adding the Quick Print button to the Quick Access toolbar, you can use this button to print a 
single copy of all the information in the current work- sheet, including any charts and graphics — but 
not including comments you add to cells. 

 
When you click the Quick Print button, Excel routes the print job to the Windows print queue, 

which acts like a middleman and sends the job to the printer. While Excel sends the print job to the 
print queue, Excel displays a Printing dialog box to inform you of its progress (displaying such 
updates as Printing Page 2 of 3). After this dialog box disappears, you are free to go back to work in 
Excel. To stop the printing while the job is still being sent to the print queue, click the Cancel button 
in the Printing dialog box. 

 

If you don’t realize that you want to cancel the print job until after Excel finishes shipping it to the 
print queue (that is, while the Printing dialog box appears onscreen), you must: 
 

1.Click the printer icon in the Notification area at the far right of the Windows taskbar (to the 
immediate left of the current time) with the secondary mouse button to open its shortcut menu. 

 

This printer icon displays the ScreenTip 1 document(s) pending for so-and-so. For example, when 
I’m printing, this message reads 1 document(s) pending for Greg when I position the mouse pointer 
over the printer icon. 

2.Right-click the printer icon and then select the Open All Active Printers command from its shortcut 
menu. 

 

This opens the dialog box for the printer with the Excel print job in its queue (as described under 
the Document Name heading in the list box). 
 

3.Select the Excel print job that you want to cancel in the list box of your printer’s dialog box. 
4.Choose Document ➪Cancel from the menu bar and then click Yes to confirm you want to cancel the 

print job. 
5.Wait for the print job to disappear from the queue in the printer’s dialog box and then click the 

Close button to return to Excel. 
 

My Page Was Set Up! 
About the only thing the slightest bit complex in printing a worksheet is figuring out how to get the 

pages right. Fortunately, the command buttons in the Page Setup group on the Ribbon’s Page Layout 
tab give you a great deal of control over what goes on which page. 

 

Three groups of buttons on the Page Layout tab help you get your page set- tings exactly as you 
want them. The Page Setup group, the Scale to Fit group, and the Sheet Options group are described in 
the following sections. 

 

To see the effect of changes you make in the Worksheet area, put the work- sheet into Page Layout 
View by clicking the Page Layout button on the Status bar while you work with the command buttons 
in the Page Setup, Scale to Fit, and Sheet Options groups on the Page Layout tab of the Ribbon. 
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Using The Buttons in The Page Setup Group 
The Page Setup group of the Page Layout tab contains the following important command buttons: 

✓ Margins button to select one of three preset margins for the report or to set custom margins on the 
Margins tab of the Page Setup dialog box. 

✓ Orientation button to switch between Portrait and Landscape mode for printing. (See the “Getting 
the lay of the landscape” section, later in this chapter.) 

✓ Size Button to select one of the preset paper sizes, set a custom size, or change the printing 
resolution or page number on the Page tab of the Page Setup dialog box. 

✓ Print Area button to set and clear the print area. (See the nearby “Understanding and using the 
print area” sidebar.) 

✓ Breaks Button to insert or remove page breaks. (See “Solving Page Break Problems” later in this 
chapter.) 

✓ Background Button to open the Sheet Background dialog box where you can select a new 
graphic image or photo to use as a background for the current worksheet. (This button changes to 
Delete Background as soon as you select a background image.) 

✓ Print Titles button to open the Sheet tab of the Page Setup dialog box where you can define rows 
of the worksheet to repeat at the top and columns of the worksheet to repeat at the left as print titles 
for the report. 

 

Massaging the margins 
The Normal margin settings that Excel applies to a new report uses standard top, bottom, left, and 

right margins of 3⁄4 inch with just over a 1⁄4 inch separating the header and footer from the top and 
bottom margin, respectively. 

 
In addition to the Normal margin settings, the program enables you to select two other standard 

margins from the Margins button’s drop-down menu: 
✓ Wide margins with 1-inch top, bottom, left, and right margins and 1⁄2 inch separating the header 
and footer from the top and bottom margin, respectively. 
✓ Narrow margins with a top and bottom margin of 3⁄4 inch and a left and right margin of 1⁄4 inch with 
0.3 inch separating the header and footer from the top and bottom margin, respectively. 
Frequently, you find yourself with a report that takes up a full printed page and then just enough to 
spill over onto a second, mostly empty, page. To squeeze the last column or the last few rows of 
the worksheet data onto Page 1, try selecting Narrow on the Margins button’s drop-down menu. 
If that doesn’t do it, you can try manually adjusting the margins for the report from the Margins tab 
of the Page Setup dialog box or by dragging the margin markers in the preview area of the Print 
panel in the Backstage View (Press Ctrl+P and click the Show Margins button). To get more 
columns on a page, try reducing the left and right margins. To get more rows on a page, try 
reducing the top and bottom margins. 

To open the Margins tab of the Page Setup dialog box (shown in Figure 5-4), click Custom Margins on the 
Margins button’s drop-down menu. There, enter the new settings in the Top, Bottom, Left, and Right text 
boxes — or select the new margin settings with their respective spinner buttons. 

 


